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Getting Started: IB Investment Manager
Getting Started: IB Investment Manager

This Getting Started guide provides a comprehensive collection of the tasks you will want to 
complete as a new IB Investment Manager of a Hedge and Mutual Fund Account - Multiple 
Fund Account. The guide assumes that you are the investment manager.

As an IB Investment Manager of an Multiple Fund Account, you manage one or more Hedge or 
Mutual Fund accounts, with each Fund account owned by a separate legal entity and 
credit-managed separately. In a Multiple Fund Account, you add Fund accounts, deposit funds 
directly into each Fund account and trade for them in TWS using pre-trade allocations. You can 
also add multiple users to the Master account. 

Please note that this guide is designed as a reference for new users, and comprises a very 
small subset of the information and trading features available to you through IB and the TWS.

Must Consider:
•   Understand how to Log In to Account Management.

•   Activate your Secure Login System passcode device.

•   Fund the Master Account in a Multiple Fund Account.

•   Add Fund Accounts to a Multiple Fund Account.

•   Fund the Trading (Fund) Account in a Multiple Fund Account.

•   Check Fund Account Funds Status.

•   Configure Trading Permissions.

•   Start to trade:

•   Subscribe to Market Data.

•   Log in to TWS.

•   Add Market Data Lines.

•   Define Allocation Groups and Methods.

•   Trade and Allocate for Funds.

•   Real-time Activity Monitoring.

May Want to Consider:
•   Use Post Trade Allocations.

•   Add Users to the Account

•   Statements and Reports

•   Open a PaperTrader Account

•   Use Soft Dollars
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Log In to Account Management
Log In to Account Management

Note:   The information in this section applies to all IB Fund accounts.

There are two ways to access Account Management:

•   Log in from the IB website.

•   Access the home page from the Trader Workstation.

To log in to Account Management from the IB website

1   From IB’s web site, select Account Management from the Login dropdown list in the 
upper right corner.

2   Enter your IB Username and Password, and click Login. The Account Management 
home page opens.

Failed Login Attempts

After ten failed login attempts in 24 hours, your Account Management login will be disabled. If 
this happens, contact Customer Service.
Getting Started: IB Investment Manager 5

http://institutions.interactivebrokers.com/en/p.php?f=customerService&ib_entity=llc


Log In to Account Management
To access Account Management from Trader Workstation

1   Log in to Trader Workstation.

2   From the Account menu, select Account Management Home. The Account Management 
home page opens.

Automatic Logoff

If you are logged into Account Management and the system detects no activity for 30 minutes, 
your Account Management session will automatically expire and you will have to log back in. A 
message appears warning you that you will automatically be logged out without further 
activity.

Once your session expires, another message appears informing you that your session has 
expired and you have been logged out. You must re-login to start a new Account Management 
session.
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Secure Login System
Secure Login System

Note:   The information in this section applies to all IB Fund accounts.

Once your account is approved and funded, IB will mail you a security device at the address 
you specified in your application. You will need to use your device anytime you log in to TWS 
or Account Management. This added level of security helps to ensure that your IB account 
information remains secure. Please note that your device must be activated before you can 
use it. 

Note:   We strongly encourage you to activate your security device upon receipt. If you do 
not, IB will automatically activate the card 14 days after the card is mailed, and you 
will not be able to access your account without it.

To activate your security device

1   Log In to Account Management.

2   Click Manage Account > Security > Secure Login System.

3   Follow the instructions on the screen to activate your security device.

For more information about our Secure Login System, including detailed instructions on how 
to use each type of security device, see the Account Management Users’ Guide.
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Secure Login System
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Funding: 
Funding

This section describes how to fund your Multiple Fund Account.

In a Multiple Fund Account, you optionally fund the Master account, then you fund each 
trading account (individual Fund accounts) you manage. Certain fees, such as market data 
fees for the Fund accounts that you manage, are withdrawn from the Master account, so you 
should deposit enough funds in your Master account to allow for market data fees for one 
year. Deposit funds into the Master and trading accounts using the Funds Management 
functions in Account Management.
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Funding: Fund the Master Account in a Multiple Fund Account
Fund the Master Account in a Multiple Fund Account

While it is not mandatory to fund the master account, we recommend you do this, as certain 
fees, including market data fees, are withdrawn directly from the master account. Should your 
master account accrue a negative balance at any time, market data will be terminated. We 
suggest funding the master account with a minimum of $500.00, or the estimated amount of 
one year’s market data fees. 

For details on methods available for funding an account, see the Funding Reference on the IB 
web site. 

To deposit funds directly into the master account of a Multiple Fund Account

1   Log In to Account Management.

Note:   If you have already received your Secure Login System device and it has been 
activated, you will need it to access Account Management and to complete your fund 
deposit request.

2   Click Funding > Fund Transfers.

3   From the Transaction list, select Deposit.

4   Select your currency from the Currency list.

5   In the Method list, select a deposit type.

6   Type the amount of your intended deposit in the Amount field.

7   You are asked if you want to use previously saved bank information.

•   Yes - Use saved bank information for new transfer request
Select this option if you want to use previously saved bank information for this 
deposit request.

•   No - Create new transfer request with new bank information
Select this option if you want to save new bank information for this deposit 
request. This option is automatically selected if you do not have any saved any 
bank information.

•   No - Create new bank information only
Select this option if you only want to create new saved bank information without 
transferring any funds.
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Funding: Fund the Master Account in a Multiple Fund Account
8   If you are not using previously saved bank information, be sure to enter a Name for the 
bank instruction that will be saved with your bank information. You will be able to use 
this bank instruction for future deposit notifications without having to re-enter your 
bank information.

9   Decide if you want to save the information as a recurring transaction. If you answer Yes, 
complete the fields in the section that appears.

10  Click Continue.

11  Verify that all deposit information is correct and make note of any special instructions 
that appear on the screen. 

•   For example, for a wire deposit, you will have to instruct your bank to wire the 
funds to the institution shown on the screen. 

•   For a check deposit, you will have to mail your check with a copy of the 
confirmation screen to the address shown on the screen.

12  Click Continue. If you need to modify any information, click Cancel and modify the 
deposit information.

After you have funded your Master account, add individual Fund Accounts as described in Add 
a Fund Account to the Master Account.
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Funding: Check Fund Account Funds Status
Check Fund Account Funds Status

You can check the status of any fund transaction within the last 90 days for your Multiple Fund 
account at any time on the View Transaction History page in the Funding menu of Account 
Management. 

In a Multiple Fund Account, select the account whose status you want to check using the 
Client Account ID pull-down. 

The View Transaction History page shows all cash transactions, position transfers, bank 
instructions and internal transfers for an account initiated in the last 45 days.

Note:   If you have already received your Secure Login System device and it has been 
activated, you will need it to access the Transaction History page.

You can also check the cash balance of for your Multiple Fund account at any time on the 
Funding > Fund Transfers page in Account Management. 

In a Multiple Fund Account, select the account whose status you want to check using the 
Account Selector at the top of the page. 

The page displays the Cash Balance, Cash Available for Withdrawal, Withdrawable cash that is 

subject to any origination restrictions (including ACH deposits initiated by the customer via the 
IB website) and the amount of any pending deposit that has not yet posted to the account.

Note:   If you have already received your Secure Login System device and it has been 
activated, you will need it to access the Fund Transfers page.
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Configure Trading Permissions
Configure Trading Permissions

As Investment Manager of an Multiple Fund Account, you are responsible for configuring the 
Trading Permissions for the Fund Accounts that you manage. This includes their Account Type 
(Reg T Margin, Portfolio Margin or Cash) and trading permissions, which identify the products 
you wish to trade and the countries in which you want to trade them. 

Configure trading permissions in Account Management by clicking Manage Account > Trade 
Configuration > Permissions.

For additional information on Account Types, as well as detail on the products and countries 
which are available, please visit our Trading Configuration page.
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Starting to Trade: 
Starting to Trade

The Trader Workstation (TWS) is a robust platform which allows access to a variety of 
powerful tools, including the Rebalance tool, Basket Trader, Option Trader and the 
Accumulate/Distribute Algorithm. Information about all of the tools which IB offers can be 
found on the Trading Tools page on the IB web site.

This section of the guide will focus on TWS basics and will show you how to:

•   Subscribe to Market Data;

•   Log in to TWS;

•   Add Market Data Lines (ticker lines) to the TWS trading window;

•   Define Allocation Groups and Methods in TWS;

•   Trade and Allocate for Funds using the methods you defined;

•   Monitor clients’ trade activity, positions and P&L, and account balances using our 
Real-time Activity Monitoring tools.
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Starting to Trade: Subscribe to Market Data
Subscribe to Market Data

Before you begin trading, you will want to subscribe to market data through Account 
Management. Although you can trade without data, IB does not recommend it.

To subscribe to Market Data

1   Log In to Account Management using your IB username and password.

2   In the left pane, select Trading Access, then Research & Market Data Subscriptions.

3   Subscribe to research and news services, then click Continue. 

4   Scroll down and check the subscriptions you would like to receive.

Note:   Most market data fees are automatically withdrawn from the Master account 
monthly, and data may be suspended if the master account does not have sufficient 
funds to cover market data expenses.

5   Click Continue.

6   Read and complete the necessary Subscriber Agreements, and click Continue.

Most market data subscription requests and changes take effect immediately. Certain market 
data subscriptions, such as the subscription to the NYSE data, require approval from the 
exchange and therefore will not take effect immediately. For example, a NYSE market data 
subscription takes approximately five business days upon receipt of the market data 
agreement to take effect.

For more information on market data subscriptions and how to choose the appropriate 
subscriptions for your trading needs, please click the Depth of Book Detail link from the 
market data subscriptions page on the IB web site.
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Starting to Trade: Log in to TWS
Log in to TWS

The first time you log in to TWS, you’ll need to take a little time to populate your screens with 
data, understand the different allocation methods you can use, and finally practice creating 
orders. 

Note:   We strongly recommend that you Open a PaperTrader Account so that you can 
familiarize yourself with Trader Workstation’s many features without accidently 
submitting a trade.

You can run TWS directly from your Internet browser, or download the software to your PC 
and launch it directly from your desktop. For more information, see the Trader Workstation 
page on the IB web site.

To log in from your browser

1   In the Login box in the upper right corner of the homepage, select Trader Workstation 
from the drop-down list.

2   In the Login box, enter your username and password and click Login.

For more information on using browser-based TWS versus the standalone version, see the 
TWS Users’ Guide.
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Starting to Trade: Add Market Data Lines
Add Market Data Lines

Next, you’ll want to add market data, or ticker lines, for the products you for which you want 
to view data or trade. Although you can trade without market data, we don’t recommend it.

To add market data lines to the trading window

1   Click in the Contract field in an empty row.

2   Enter an underlying symbol and press ENTER. 
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Starting to Trade: Add Market Data Lines
3   Select an asset type from the picklist on the trading screen. For instruments that require 
an expiry, choose a month and year, or select All to open the contract selection box. 

If you choose Smart as the exchange (rather than selecting Directed and then picking a 
destination) the market data is aggregated and the default order routing is Smart. 
From a display perspective, ticker lines that use aggregated Smart data do not display 
Smart in the data line. TWS will only show the exchange if you elect to direct route. 
When you create an order, regardless of the market data selection you can modify the 
order routing destination on a per-order basis using the Destination field. 
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Starting to Trade: Add Market Data Lines
4   In the Contract Selection box, choose a contract(s) and click OK. You can limit the 
contracts displayed in the right pane by selecting criteria from the Filter section. Choose 
Smart as the exchange to use SmartRouting.

For more information on market data in TWS, see the TWS Users’ Guide.
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Starting to Trade: Define Allocation Groups and Methods
Define Allocation Groups and Methods

IB offers advisors a number of ways to allocate trades across multiple accounts based on a 
single order entry. By using our Account Groups, you can allocate to your accounts by allowing 
IB to calculate the distribution based on: a specified percent change of an existing position, 
the amount of available equity with loan value per account, the net liquidation value per 
account, or as an equal split between all accounts in a group. 

Additionally, using our Profiles, you can manually define how a trade will allocate orders 
among a group of accounts, by number or percent of shares.

Account Groups
Account Groups will automatically calculate ratios and allocate order shares to a pre-defined 
group of accounts based on the selected allocation method. When you create an order and 
choose a group, the order uses the default method to allocate shares amongst the accounts in 
the group.

To create an Account Group

1   On the Edit menu, select Global Configuration.

2   On the Configuration screen, click Advisor in the left pane to expand that selection, then 
select Account Groups.

3   Click the Create button on the right side of the window. 

4   Enter an Account Group name. Do not use the name "All" since this is reserved by the 
system. 

Note:   You may want to include a prefix such as "AG" in the name to identify the choice as 
an Account Group when it appears in the order selection list.

5   Select a default allocation method. You can change the allocation method for each 
order. Select from one of the following:

PctChange - This method increases or decreases an already existing position by the 
specified percentage. Do not specify an order size. The quantity is calculated by the 
system and is displayed in the Quantity field after the order is acknowledged. 
Positive percents will increase a position, negative percents will decrease a position. 

BUY 
ORDER 

Positive 
Percent

Negative 
Percent 

Long 
Position

Increases 
position

No effect

Short 
Position 

No effect Decreases 
position

SELL 
ORDER 

Positive 
Percent

Negative 
Percent 
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Starting to Trade: Define Allocation Groups and Methods
Example 1: Assume that three of the six accounts in this group hold long positions in 
stock XYZ. Client A has 100 shares, Client B has 400 shares, and Client C has 200 
shares. You want to increase their holdings by 50%, so you enter "50" in the 
percentage field. The system calculates that your order size needs to be equal to 350 
shares. It then allocates 50 shares to Client A, 200 shares to Client B, and 100 shares 
to Client C. 

Example 2: You want to close out all long positions for three of the five accounts in a 
group. You create a sell order and enter "-100" in the Percentage field. The system 
calculates 100% of each position for every account in the group that holds a position, 
and sells all shares to close the positions.

AvailableEquity - This method distributes shares based on the amount of equity with 
loan value currently available in each account. Requires you to specify an order size. 
The system calculates ratios based on the Equity with Loan value in each account and 
allocates shares based on these ratios.

Example: You transmit an order for 700 shares of stock XYZ. The account group 
includes three accounts, A, B and C with available equity in the amounts of $25,000, 
$50,000 and $100,000 respectively. The system calculates a ratio of 1:2:4 and 
allocates 100 shares to Client A, 200 shares to Client B, and 400 shares to Client C.

NetLiq - This method distributes shares based on the net liquidation value of each 
account. Requires you to specify an order size. The system calculates ratios based on 
the Net Liquidation value in each account and allocates shares based on these ratios.

Example: You transmit an order for 700 shares of stock XYZ. The account group 
includes three accounts, A, B and C with Net Liquidation values of $25,000, $50,000 
and $100,000 respectively. The system calculates a ratio of 1:2:4 and allocates 100 
shares to Client A, 200 shares to Client B, and 400 shares to Client C.

EqualQuantity - This method distributes shares equally between all accounts in the 
group. Requires you to specify an order size. 

Example: You transmit an order for 400 shares of stock ABC. If your Account Group 
includes four accounts, each account receives 100 shares. If your Account Group 
includes six accounts, each account receives 66 shares, and then 1 share is allocated to 
each account until all are distributed.

6   The list of accounts in the Non Group Accounts section includes all accounts available to 
you. To add an account to the group, select a Non Group account and click Add. 

7   Click OK to save the group and its settings.

Long 
Position

No effect Decreases 
position

Short 
Position 

Increases 
position

No effect
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Starting to Trade: Define Allocation Groups and Methods
Create Allocation Profiles
Using our Profiles, you can manually specify how an order will allocate among a group of 
accounts by predetermining the number of shares/contracts, or defining specific percentages 
or ratios at which a trade will allocate.

To create a share allocation profile

1   On the Edit menu, select Global Configuration.

2   On the Configuration screen, click Advisor in the left pane to expand that selection, then 
select Allocation Profiles.

3   Click Create and enter a profile name, preferably one based on the way you plan to 
allocate shares between clients. 

Note:   You may want to include a prefix such as "AP" in the name to identify the choice as 
an Allocation Profile when it appears in the order selection list.

4   In the Allocation Profile specifies area, select a method of allocating shares between 
accounts: 

•   Percentages - this method will split the total number of shares in the order 
between listed accounts based on the percentages you indicate. For example, an 
order for 1000 shares using a profile with four accounts at 25% each would 
allocate 250 shares to each listed account in the profile.

•   Ratios - this method calculates the allocation of shares based on the ratios you 
enter. For example, an order for 1000 shares using a profile with four accounts set 
to a ratio of 4, 2, 1, 1 would allocate 500, 250, 125 and 125 shares to the listed 
accounts, respectively.

•   Shares - this method allocates the absolute number of shares you enter to each 
account listed. If you use this method, the order size is calculated by adding 
together the number of shares allocated to each account in the profile.

5   Click in the Account field to view all accounts. Select an account and tab over to the 
Value field.

6   Enter the percent, ratio or number of shares to be allocated to the selected account (you 
may need to delete the current value). Tab to create a new account line. 

Note:   If you use percentages to allocate shares, percentages allocated must equal 100. If 
you use ratios, The system automatically calculates these percentages. 

7   Continue until you have listed all the desired accounts for the current profile, and click 
OK.
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Starting to Trade: Define Allocation Groups and Methods
Set Allocation Defaults
The default allocation refers to the allocation that will be used automatically when you create 
an order. You can modify the allocation on a per trade basis, and change the default 
allocations at any time. 

To set default allocations

1   On the Edit menu, select Global Configuration.

1   On the Configuration screen, click Advisor in the left pane to expand that selection, then 
select Default Allocation.

2   Select default settings, which are described below:

•   Use currently subscribed account - check this button to automatically allocate 
trades to the account or group selected in the Select Account dropdown on the trading 
window, as shown in the image above.

•   Use specified default - check this button to set a specified absolute default allocation.

•   Automatic Allocation - choose a user-defined Account Group and method to use 
for default allocation.

•   Manual Allocation - choose an Allocation Profile to use as the default.

•   Single Account Allocation - choose an individual account to use as the default 
allocation. NOTE: To allow the last selected individual account to be used for the 
default allocation going forward, select the Use currently subscribed account radio 
button at the top of the page. 
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Starting to Trade: Define Allocation Groups and Methods
•   Preserve default - select to always use the default set up in the Default Allocation 
window regardless of changes you make on a per-order basis. If this is checked, you will 
need to use this window to modify the default allocation.

•   Use last submitted as a default - select if you want the default allocation to change 
to the allocation you set on a per-order basis. If this is checked, the default allocation 
automatically changes when you change the allocation on an order.If one or more 
accounts fails to meet the margin requirements when an order is submitted - 
For each order, all accounts designated for order allocation are vetted before the order 
is submitted, to ensure that each account has the capacity to support the designated 
allocation. In cases where one or some account(s) cannot hold the allocation as 
specified, the advisor can elect to:

•   Reject the entire order - The entire order is rejected.

•   Reduce the size of the order - The order size is reduced by the quantity that 
cannot be held, and this quantity is deactivated.

Note:   Note that once the order has been submitted and is working, the quantity of the 
working order may still change. For example, if an unrelated fill results in one or 
more of the accounts no longer being able to support the allocation, the order size 
will be reduced by that quantity. In an opposite scenario, if an account whose 
allocation was deactivated can now support the allocation, a quantity that was 
deactivated during the initial order submission may be reactivated and submitted. 
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Starting to Trade: Trade and Allocate for Funds
Trade and Allocate for Funds

Once you have ticker lines in Quote Monitor and defined your account groups and/or allocation 
profiles, you’re ready to start trading. There are many different ways to create and send 
orders from within TWS, but at this point we will focus on creating and sending orders directly 
from the ticker line in the Quote Monitor. 

You create an order from the Quote Monitor by clicking the bid or ask on the ticker line of the 
asset you want to trade. TWS automatically creates the order directly beneath the related 
ticker. We call this a double-line display, and it’s helpful to understand that the double row of 
headers along the top of the window corresponds to the double-line market data/order row 
display in the body of the window. The column headings in the top row correspond to data in 
ticker line. 

Imagine now that I click the Ask price in the IBM ticker line. An order to buy 100 shares of IBM 
stock is created directly below the ticker, and the column titles on the bottom row apply to 
these fields, with the Allocation = Group 1, Method = Avail, TIF = DAY and so on. 

To create and transmit an order from the trading window

1   Click the "Ask" or "Bid" price of an asset to create an Order Management line directly 
below the asset’s ticker.

•   Clicking the Ask will create a Buy order.

•   Clicking the Bid will create a Sell order.

2   Use the Allocation field dropdown list to select an Account Group, Account Profile, a 
single account or All accounts.

or

Right-click on the order and select Modify then select Share Allocation.
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Starting to Trade: Trade and Allocate for Funds
3   In the Allocation dialog box, select an Account Group in the Automatic Allocation area, 
an Account Profile in the Manual Allocation area, or select a single account..

•   For the Account Group, modify the allocation method if necessary. If you choose 
the PctChange method, enter a positive or negative value in the Percentage field. 
All other automatic allocation methods are calculated using the order size.

•   If you use an Allocation Profile, select a group name.

•   To allocate all shares to one account, select a single account.

4   Click OK to complete the order.

5   To Transmit, click the red "T" in the Transmit field.
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Starting to Trade: Real-time Activity Monitoring
Real‐time Activity Monitoring

The Account window lets you monitor every aspect of your Fund account activity. The Account 
window displays, among other things, the values of your positions, the funds available for 
trading and the amount of margin cushion an account has before it may become subject to a 
liquidation, all with real-time values.

The Account window is divided into the following sections: 

•   Balances, which shows your account balances for securities, commodities and in total. 
These balances don't include margin requirements.

•   Margin Requirements, which show your initial and maintenance margin requirements 
based on your current portfolio. 

•   Available for Trading, which tells you what you have for additional trades and cushion 
before liquidation, based on your balance information and margin requirements.

•   Market Value, shows the total value of all positions, sorted by currency.

•   FX Portfolio, which shows activity for currency pair trades only. The value in the Position 
field only reflects trades executed in the FX market. Please note that these do not 
reflect real-time FX positions, since the non-base currency conversions are not included.

•   Portfolio, which lists all current positions sorted by underlying, and displays the total 
current market value for each position.

To open the Account window

On the main trading Toolbar, click the Account icon, or select Account from the View menu.
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Starting to Trade: Real-time Activity Monitoring
The first time you open the Account window, "key" account values display by default (this 
default view is shown in the illustration below). The sections can be expanded and customized 
by clicking the green “+” sign to the right of each section and using the checkboxes to specify 
those fields you want set as your default view. 
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Starting to Trade: Real-time Activity Monitoring
Investment Managers and other multi-client account holders will see a drop-down Select 
Account field on the Account and Summary tabs to select either an individual account or an 
account group. 

On the Account page, elect to display account information for All accounts, any individual 
account including the Master, or a user-defined Account Group, which includes a subset of 
accounts (in the image above, Group 1 is a user-defined account groups). 

On the Summary page, choose to view the account summary for All accounts, or for any 
Account Group. 

You can also print the summary page by selecting Print Summary from the File menu.
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Starting to Trade: View Account Balances
View Account Balances

The Balances section shows your balances for securities, commodities and in total for your 
Single or Multiple Fund Account. These balances don't include margin requirements. 

To view all Balances values, expand the section using the green plus (+) sign. To customize 
this view to show only the values you want to see, put a check next to these parameters and 
click the green minus (-) sign to contract the section.

The following table defines the fields available in the Balances section. 

Parameter Securities Commodities
Net Liquidation 
Value

Total cash value + stock value + 
securities options value + bond 
value + fund value.

Total cash value + commodities 
options value.

Equity with 
Loan Value

Cash Account: Settled Cash.
Margin Account: Total cash value 
+ stock value + bond value + fund 
value + European & Asian options 
value.

Cash Account: Total cash value + 
commodities option value - futures 
maintenance margin requirement 
+ minimum (0, futures P&L).
Margin Account: Total cash value 
+ commodities option value - 
futures maintenance margin 
requirement.

Previous Day 
Equity with 
Loan Value

Marginable Equity with Loan Value 
as of 16:00 ET the previous day.

Not applicable.

Reg T Equity 
with Loan Value

Cash Account: Settled Cash.
Margin Account: Total cash value 
+ stock value + bond value + fund 
value + non-U.S. & Canadian 
securities options value.

Cash Account: Total cash value + 
commodities option value - futures 
maintenance margin requirement 
+ minimum (0, futures P&L).
Margin Account: Total cash value 
- futures maintenance margin 
requirement.

Special 
Memorandum 
Account 

Max ((EWL - US initial margin 
requirements)*, (Prior Day SMA 
+/- change in day's cash +/- US 
initial margin requirements** for 
trades made during the day.))
*calculated end of day under US 
Stock rules, regardless of country 
of trading. 
**at the time of the trade

Not applicable.
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Securities 
Gross Position 
Value (GPV)

Long Stock Value + Short Stock 
Value + Long Option Value + Short 
Option Value + Fund Value

Cash Settled cash + sales at the time of 
trade

Settled cash + sales at the time of 
trade + futures P&L

Settled Cash Cash recognized at the time of 
settlement - purchases at the time 
of trade - commissions - taxes - 
fees.
Stock Settlement: Trade date + 3 
days
Options Settlement: Trade date + 
1 day

Same as for Securities.
Futures Settlement: Trade date + 
1 day

Accrued 
Interest

Interest that has accumulated but 
has not been paid or charged.

Same as for Securities.

Parameter Securities Commodities
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Starting to Trade: Real-time Margin Monitoring
Real‐time Margin Monitoring

Use real-time margin monitoring to see your current margin requirements at a glance, and to 
understand the margin implications of any transaction before you transmit an order. 

To view real-time margin requirements

1   On the View menu, select Account.

2   The Account window shows your account details, including the current market value and 
portfolio.

3   Use the Margin Requirements and Trading Limits section to monitor your margin.

You can also see the margin impact for a single order using the right-click Preview Order 
command from an order line on the trading window. An example of the Order Preview window 
is shown below.
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Starting to Trade: Real-time Margin Monitoring
To preview margin impact

1   Use the right-click menu from an order line to select Check Margin.

2   View the order details before you transmit, including commissions, margin impact and 
the order description.

3   Click Transmit to send the order from the Preview window, or Close to modify before 
sending.

Note:   This feature is valid only for single-account orders. It does not work for allocated 
orders.
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Monitor Margin Requirements
Margin is calculated in real time throughout the trading day, but displayed for three periods 
during the day: the market's open, the market's close, and overnight. The Margin 
Requirements section shows your current margin, projected margin for the next period of 
margin calculation (Look Ahead) and the Overnight calculation (valid for futures only). 

•   The Current margin is your real-time requirement right now. If you happen to be 
viewing this screen at 1:00 AM, your current and overnight margin values for your 
futures positions will be identical. If you're viewing this screen during trading hours, 
your current margin requirements for futures will be less than or equal to the overnight 
requirement.

•   The Look Ahead projects what your margin requirements will be at the next margin 
calculation, based on what you have in your portfolio now. If you're viewing this screen 
at 2:00 PM, the next calculation will be at the close. If you're viewing this screen at 
1:00 AM, the next calculation will be at the open.

•   Overnight is the requirement after regular market hours and only applies to futures.

To view all Margin Requirements values, expand the section using the green plus (+) sign. To 
customize this view to show only the values you want to see, put a check next to these 
parameters and click the green minus (-) sign to contract the section.

Try PM

Click to see how your margin requirements would be different if you had a portfolio margin 
account instead of a RegT margin account.

Soft Edge Margining

To help you stay on top of your margin requirements, we now provide pop-up messages and 
color-coded account information to notify you that you are approaching a serious margin 
deficiency. TWS will highlight the row whose value is in the distress state. The colors on your 
account screen tell you the following:

Yellow - You have only a 5% cushion above the margin requirement

Orange - Your margin cushion is depleted and you have a short time to enter into 
margin-reducing trades before your positions are liquidated. During this time you should be 
able to enter a trade that will decrease your margin requirement, but not increase.

Red - Your positions will shortly start to be liquidated as necessary to bring your account back 
within the margin limits. 

The following table defines the fields available in the Margin Requirements section. 

Parameter Securities Account Commodities Account
Reg T Margin Initial margin requirements 

calculated under US Regulation 
T rules.

Initial margin requirements 
calculated under US Regulation 
T rules.

Current Initial 
Margin

Initial margin requirement in the 
base currency of the account. The 
initial margin requirement is what 
is required to open a new position.

Initial margin requirement in the 
base currency of the account. The 
initial margin requirement is what 
is required to open a new position.
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Please see the Margin Overview page on the IB website for details on margin calculations.

Current 
Maintenance 
Margin

Maintenance margin requirement 
in the base currency of the 
account. This is the value required 
to maintain your current positions.

Maintenance margin requirement 
in the base currency of the 
account. This is the value required 
to maintain your current positions.

Look Ahead 
Initial Margin

Initial margin requirement as of 
next period's margin change in the 
base currency of the account. 

Initial margin requirement as of 
next period's margin change in the 
base currency of the account. This 
value depends on when you are 
viewing your margin 
requirements. If it is 3:00 pm ET, 
the next calculation you're looking 
ahead to is after the close, or the 
Overnight Initial Margin (100%). If 
it's 3:00 am ET, the next 
calculation will be at the market's 
open (50%).

Look Ahead 
Maintenance 
Margin

Maintenance margin requirement 
as of next period's margin change 
in the base currency of the 
account.

Maintenance margin requirement 
as of next period's margin change 
in the base currency of the 
account. This value depends on 
when you are viewing your margin 
requirements. If it is 3:00 pm ET, 
the next calculation you're looking 
ahead to is after the close, or the 
Overnight Initial Margin (100%). If 
it's 3:00 am ET, the next 
calculation will be at the market's 
open (50%).

Overnight 
Initial Margin

Not applicable for securities. Overnight initial margin 
requirement in the base currency 
of the account. The overnight 
calculation for futures is 100%.

Overnight 
Maintenance 
Margin

Not applicable for securities. Overnight maintenance margin 
requirement in the base currency 
of the account. The overnight 
calculation for futures is 100%.

Parameter Securities Account Commodities Account
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Starting to Trade: View Available for Trading Values
View Available for Trading Values

If you look at nothing else on the Account Screen, the Available for Trading values let you 
know the state of your for your Single or Multiple Fund Account at a glance. Your Available 
Funds tells you if you can put on a trade. Your Excess Liquidity tells you whether you have 
sufficient cushion to maintain your current positions, and your Buying Power tells you how 
much you have at your disposal including your equity and IB's margin.

To view all Available for Trading values, expand the section using the green plus (+) sign. To 
customize this view to show only the values you want to see, put a check next to these 
parameters and click the green minus (-) sign to contract the section.

The following table defines the fields available in the Available for Trading section. 

Parameter Securities Account Commodities Account
Current 
Available 
Funds

This value tells what you have available for 
trading. 
Equity with Loan Value - Initial margin.

Same.

Current 
Excess 
Liquidity

This value shows your margin cushion, before 
liquidation.
Equity with Loan Value - Maintenance margin.

Same.

Look Ahead 
Available 
Funds

This value reflects your available funds at the 
next margin change. The next change is 
displayed in the Look Ahead Next Change field.
Equity with loan value - look ahead initial 
margin.

Net Liquidation value - 
look ahead initial 
margin.

Look Ahead 
Excess 
Liquidity

Equity with loan value - look ahead maintenance 
margin.

Net Liquidation value - 
look ahead maintenance 
margin.

Overnight 
Available 
Funds

Same as during regular trading hours. Net Liquidation value - 
Overnight Maintenance 
margin

Overnight 
Excess 
Liquidity

Same as during regular trading hours. Net Liquidation value - 
Overnight Maintenance 
margin.
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Buying 
Power

Cash Account: (Minimum (Equity with Loan 
Value, Previous Day Equity with Loan 
Value)-Initial Margin) 
Standard Margin Account: Available Funds*4

Not applicable for 
futures.

Leverage Gross Position Value/Net Liquidation. Same.

Look Ahead 
Next 
Change

Shows you when the next margin period will 
begin.

Same.

Day Trades 
Left

Number of day trades still available for 4-day 
pattern day trader period.

Not applicable for 
futures.

Parameter Securities Account Commodities Account
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Starting to Trade: View Market Value
View Market Value

The Market Value section shows you total value for all assets sorted by currency. Accounts 
with the ability to make transfers between brokers will also have an In Transit tab to monitor 
DVPs and other position transfers. In addition, the Cash column of this section is where you 
can view your real-time FX position information.

The following table defines the fields in the Market Value section. 

Parameter Description
Currency Open positions are grouped by currency.

Cash Cash recognized at the time of trade + futures P&L. 
This value reflects real-time current FX positions, including:

•   Trades executed directly through the FX market 

•   Trades executed as a result of automatic IB conversions, which 
occur when you trade a product in a non-base currency, 

•   Trades deliberately executed to close non-base currency 
positions.

Accrued 
Interest

Reflects the current month's accrued debit and credit interest to date, 
updated daily.

Stock Real-time mark-to-market value of stock.

Options Real-time mark-to-market value of securities options.

Futures Real-time change in futures value since last settlement.

FOPs Real-time mark-to-market value of futures options.

Funds Current funds balance.

Exchange Rate The currency exchange rate to the base currency.

Net Liquidation 
Value

Total cash value + stock value + options value + bond value.

Unrealized P&L The difference between the current market value of your open 
positions and the average cost, or Value - Average Cost.

Realized P&L Shows your profit on closed positions, which is the difference between 
your entry execution cost and exit execution cost, or 
(execution price + commissions to open the position) - 
(execution price + commissions to close the position). 
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View FX Portfolio Values

This section shows activity only for currency pair trades. The "Position" value reflects the sum 
of trades executed in the FX market only, and consequently does not reflect a real-time FX 
position. Check the value in the Cash field of the Market Value section for real-time FX position 
information.

The following table defines the fields available for display in the FX Portfolio section. 

Parameter Description
Contract 
description

Symbol and description.

Exchange An exchange on which the pair trades. This may not be the executing 
exchange for the trade.

Position The sum of trades executed in the FX market for the selected currency 
pair.

Unsettled Position Unsettled currency trades.

Currency Currency used to buy/sell the FX pair.

Market Value (Position) x (market price). 

Market Price Real-time price of the position.

Average Price Average price per contract.

Unrealized P&L The difference between the trade price and the market price times 
position, including commission.
Example: BUY 20,000 EUR.USD @ 1.54390
Trade Price = 1.54390
Market Price (current price) = 1.54385
1.54390 – 1.54385 = .00005
.00005 X 20,000 = 1
+ 2.5 commission = -3.50 Unrealized P&L

Realized P&L Realized profit & loss for the pair.
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Liquidate Last Last liquidation "Yes" or "No" tag. If set to "Yes" this position will be 
put at the end of the queue to liquidate last in the case of margin 
requirements. To set, use the right-click menu on the desired position.
Note:   While IB provides customers the opportunity to pre-request 

the order of liquidation in the event of a margin deficiency in 
their account, such requests are not binding on IB. In the 
event of a margin deficiency in customer’s IB account, IB 
retains the right, in its sole discretion, to determine the assets 
to be liquidated, the amount of assets liquidated, as well as 
the order and manner of liquidation. Customers are 
encouraged to consult the IB Customer Agreement and the IB 
Disclosure of Risks of Margin Trading for further information. 

Parameter Description
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View Portfolio Values

The Portfolio section shows the current value of each position and allows you to mark any 
position to be liquidated last in the event of a margin call. Accounts with the ability to make 
transfers between brokers will also have an In Transit tab to monitor DVPs and other position 
transfers.

The following table defines the fields in the Portfolio section. 

Parameter Description
Show Zero Position Rows - displays a line for all traded contracts even if the 
position was closed out.

Contract 
description

Symbol and description.

Position Quantity of long/short shares or contracts.

Currency Currency of the contract.

Market Value (Position) x (market price).

Market Price Real-time price of the position.

Average Price Average cost of stock and securities options opening positions, 
including commissions.
Note:   Right click and select Show all values in base currency 

to have TWS convert all non-base currency position 
values for display in your base currency. Converted 
values are displayed in italics for easy identification.

Unrealized P&L (Market value of positions) - (average cost).

Realized P&L (Market value of positions since close of period*) - (average 
cost for these positions).
*Cut-off times for determining realized P&L for transactions 
are as follows: 

•   20:30 ET for securities

•   Two periods for futures: 17:30 ET and 7:10 ET
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The Right-click Portfolio Menu
If you select an asset in the Portfolio section and click your right mouse button, you will have 
access to the following menu items. 

Liquidate Last Last liquidation "Yes" or "No" tag. If set to "Yes" this position 
will be put at the end of the queue to liquidate last in the case 
of margin requirements. To set, use the right-click menu on 
the desired position.
Note:   While IB provides customers the opportunity to 

pre-request the order of liquidation in the event of a 
margin deficiency in their account, such requests are 
not binding on IB. In the event of a margin deficiency 
in customer’s IB account, IB retains the right, in its 
sole discretion, to determine the assets to be 
liquidated, the amount of assets liquidated, as well as 
the order and manner of liquidation. Customers are 
encouraged to consult the IB Customer Agreement 
and the IB Disclosure of Risks of Margin Trading for 
further information. 

Parameter Description
Sort by Security 
Type

Sort positions alphabetically by security type.

Sort by Current 
Page Order

Sort positions based on their location on a trading 
page.

Parameter Description
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Trade Close Position - Transmits an appropriately sized 
opposite-side order to close our the position.
Close All Positions - Transmits multiple opposite-side 
orders to close out all positions in your portfolio.
Close Portion of Positions - In the text entry box that 
pops up, enter the percentage which will be used to 
calculate the size of each position's opposite-side 
order transmitted.

Transfer For transfer-capable accounts - initiates a DVP/RVP, 
CMTA or other transfer.

Create Ticker Creates a market data line for the contract on the 
main trading screen.

Adjust Position or 
Average Price

Only active for Forex positions. Use this feature to 
enter a hypothetical "new" position and "new" 
average cost. This feature does not modify your 
forex positions but lets you create a "what-if" to see 
total P&L including positions you may hold 
elsewhere.

Adjust Average 
Price

Displayed for all products except cash. Select a 
position and choose Adjust Average Price. Use the 
dialog box to enter a new position or change the 
average price to include transfers and corporate 
actions.

Set Liquidate Last Last liquidation "Yes" or "No" tag. If set to "Yes" this 
position will be put at the end of the queue to 
liquidate last in the case of margin requirements. To 
set, use the right-click menu on the desired position.
Note:   While IB provides customers the opportunity 

to pre-request the order of liquidation in the 
event of a margin deficiency in their 
account, such requests are not binding on 
IB. In the event of a margin deficiency in 
customer’s IB account, IB retains the right, 
in its sole discretion, to determine the 
assets to be liquidated, the amount of 
assets liquidated, as well as the order and 
manner of liquidation. Customers are 
encouraged to consult the IB Customer 
Agreement and the IB Disclosure of Risks of 
Margin Trading for further information. 

Unset Liquidate 
Last

Removes the “Liquidate Last” designation for a 
position.

Parameter Description
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For information on other real-time activity monitoring tools, including the Trades window, 
Portfolio Rebalance tool, Audit Trails, and Bulletins and System Status, see the TWS Users’ 
Guide.

Create Portfolio 
Page 

Creates a trading page called Portfolio that includes 
market data lines for all tickers in your Portfolio.

Parameter Description
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Starting to Trade: View Portfolio Values
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Use Post Trade Allocations: 
Use Post Trade Allocations

Post trade allocations let Investment Managers for Multiple Fund accounts quickly and easily 
allocate some or all trades to defined clearing brokers. 

Note:   You must define settlement instructions via the Funds Management section of 
Account Management before you will be able to allocate post trade. You typically do 
this as part of the account application process. For information about settlement 
instructions, see the Settlement Instructions page on our website.

Access post trade allocations by clicking Post Trade Allocations in the Trading Access menu in 
Account Management. You can specify post-trade clearing instructions at any time during the 
trading day, from minutes after execution until 6:00 pm ET. Post trade allocations let you:

•   Allocate any time during the day up until 6:00 pm ET. After this time, your trades will 
automatically be allocated using the selected default clearing destination.

•   Quickly unallocate any trades before 6:00 pm ET. 

•   Configure re-usable allocation templates that allow you to quickly allocate one or 
multiple trades to a pre-defined clearing broker or set of clearing brokers.
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Use Post Trade Allocations: 
•   Import allocations from a properly-formatted .csv file.

•   Create a custom Average Price trade by selecting trades for the same symbol and side 
where only the price differs. By default an average price display is expandable to show 
actual trades and trade prices.

•   Define configuration preferences including allocation settings, display preferences and 
symbol display.

•   Manage odd lots allocations. By default, the feature is set to allow round lots only. 

For complete instructions on using post trade allocations, see the Account Management Users’ 
Guide.
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Add Users to the Account
Add Users to the Account

As an IB Investment Manager, you can add users to the Master account and grant them 
access to a subset of Account Management functions, such as, trading access for additional 
traders, report management access for auditors, and so on.

To add a user to the account

1   Log In to Account Management.

2   Click Manage Account > Access Rights > Users.

3   Click Add User.

4   On the Add New User and Access Rights page, enter all required information, including 
name, five-character username prefix, password, and email address.

5   On the same page, assign Account Management functions to the user for the Master 
account by clicking the appropriate check boxes in the Functions section. If a function is 
not checked, the user will not be able to access the function in Account Management.

6   On the same page, you can assign access rights to some or all sub/client accounts that 
you want the user to access, and specify which functions you want the user to be able 
to access for the sub/client accounts.

7   Click Continue.
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8   Verify that all the information is correct, then click Continue.

If you need to make further changes, click Back, then make corrections before 
submitting.

9   Enter the confirmation number sent to you via email, then click Continue.

If you have not received a confirmation number, click Request Confirm # to have a 
confirmation number sent to your email address on record.

10  Click Cancel to cancel your changes.

Once the user has been successfully created, the process is not complete until the new user 
completes additional verification steps by logging into Account Management with the 
username and password which were created.

For more information on adding traders and other user rights topics, see the User Access 
Rights Guide.
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Statements and Reports: 
Statements and Reports

This section describes the account statements and reports available to you from within 
Account Management, including the following:

•   Activity Statements

•   Activity Downloads

•   Trade Confirmations

•   Margin Reports

•   Flex Queries

•   PortfolioAnalyst

Note:   For complete details on all of the statements and reports available, see the Reporting 
Guide.
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Statements and Reports: Activity Statements
Activity Statements

Activity statements contain information about account activity, such as positions,  cash 
balances and transactions.  Statements are generated daily, monthly, and yearly for all 
accounts. As an Investment Manager, you can view statements for your account, for individual 
client accounts, or a consolidated statement which can include some or all of your accounts. In 
addition, clients also have the ability to access their statements electronically through Account 
Management. 

Activity Statements include these features:

•   Expandable and contractible sections with click-down detail. 

•   Performances summary by asset class for a quick view of an account's profitability. 

•   Profit and loss across all transactions, positions, underlying instrument and asset class, 
under First In, First Out (FIFO), Last In, First Out (LIFO), Maximize Losses and 
Mark-to-Market (MTM) calculation methods, depending on the client’s selection. 

•   Details of change in position value for the statement period. 

•   Calculation of FX translation gains and losses for accounts with multiple currencies. 

To generate an activity statement

1   Log in to your Master account via Account Management. 

Note:  You will need your Secure Login System device to access Account Management.

2   In the left pane click Report Management, then select Activity Statements.

3   In the View Statements section of the page, make the following selections:

•   In the Statements list, select the statement template you want to use for the 
statement. Default Full includes all sections in the statement, while Default Simple 
displays a simpler monthly or daily view that excludes some sections from the 
statement. Default Summary is a simple summary statement that includes only 
these sections: NAV Summary, Profit and Loss Summary, Account Detail Section: 
Positions and Trades, Cash Report. You can also define your own customized 
statement templates.
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Statements and Reports: Activity Statements
Note:  Note that Consolidated monthly statements are available only with the 
Full Default template.

•   In the Date(s) fields, you can select one of the predefined time periods (Daily, 
Monthly or Calendar Year), or you can define a custom period to be covered by 
the statement by populating the From and To dates.

•   In the Account(s) field, select the account(s) to report on, or select Consolidated 
to include all accounts. Use Ctrl+click to select more than one account. If you 
chose to include closed accounts, those accounts appear in the list. To consolidate 
only some accounts, select Consolidate Selected Accounts, then select individual 
accounts in the Account(s) field.

•   In the Format field, select either HTML/WEB or PDF, depending on how you want 
to view the statement.

4   Click View to generate the activity statement. If you selected PDF as the Format, you 
will be prompted to open the generated report or save it to your computer.

Here is an example that shows part of an HTML-based Activity Statement.

For additional information regarding activity statements, including an explanation of 
each statement section, see the Reporting Guide.
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Statements and Reports: Activity Statements
Customized Activity Statement Templates
For those who require a simpler statement format, IB allows you to create and save 
customized statement templates. These templates enable you to include only those sections in 
the statements that you would like to view, while excluding all other sections. You create 
customized activity statement templates on the Activity Statements page in the Report 
Management section of Account Management.

For more information on how to create a customized activity statement, see Customized 
Statements in the Reporting Guide.
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Statements and Reports: Activity Downloads
Activity Downloads

IB offers a number of special download formats for activity statements so you can integrate 
your statements with third-party applications, including:

•   Microsoft Word

•   Microsoft Excel

•   Microsoft Money

•   Quicken

•   Tradelog

•   GainsKeeper

•   Captools (Legacy)

In addition, the following downloads are available upon request:

•   Daily Captools Downloads - Daily Captools downloads are available for customers upon 
request. Send your request to enable Captools downloads to 
reportingintegration@interactivebrokers.com.

If you request Daily Captools Downloads, the Activity Downloads page will contain an 
additional section for Daily Captools Downloads.

•   PortfolioCenter® (intended for institutional accounts; you must request downloadable 
files from your IB Sales Representative first).

For a complete list of offerings for institutional accounts, including PortfolioCenter®, open the 
Reference Menu in Account Management, then click Reports > Third Party Integration.

These various formats are available on the Activity Downloads page, which is accessible from 
the Report Management menu in Account Management. For additional information about 
activity downloads, see the Activity Downloads topic in the Reporting Guide.

PortfolioCenter is a product of Schwab Performance Technologies, a subsidiary of The Charles Schwab Corporation.
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Statements and Reports: Trade Confirmations
Trade Confirmations

Real-time trade confirmations are generated for all executions.  The Trade Confirmation report 
will list trade executions separately, by asset class.  Trade confirmations are available for the 
entire previous calendar year and from the start of the current calendar year.

Trade Confirmations are accessible from the Reports > Trade Confirmations menu in 
Account Management. For detailed instructions on how to view trade confirmations, see the 
Trade Confirmations topic in the Reporting Guide.

Here is an example of a Trade Confirmation report.
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Statements and Reports: Margin Reports
Margin Reports

While the real-time margin summary is displayed in the Account Window in Trader 
Workstation, our Margin Report provides you with a detailed breakdown of your positions and 
their corresponding margin requirements. In order to view this detail, you must generate the 
Margin Report from Account Management. The information contained in the Margin Report is 
based on the margin and equity values which are obtained daily at approximately 16:15 ET for 
all positions across all asset classes. Margin reports show the margin requirements for all open 
single and combination positions and are available for the previous 90 days.

Margin Reports can be accessed from the Reports > Risk menu in Account Management. For 
detailed instructions on how to view a margin report, see the Margin Reports topic in the 
Reporting Guide.

Here is an example that shows part of a margin report.
Getting Started: IB Investment Manager  57

http://institutions.interactivebrokers.com/en/software/reportguide/am/reports/marginreports.htm


Statements and Reports: Flex Queries
Flex Queries

Flex Queries let you specify exactly which fields you want to view in your Activity Statement or 
Trade Confirmation report, the time period you want the report to cover, the order in which 
you want the fields to display, and the display format, TEXT or XML, in which you want to view 
your report. 

You can create multiple templates with different fields for each statement. All of your 
templates are stored in and run from Account Management. An Activity Flex Query is different 
from an Activity Statement customized template in that you can customize a flex query at the 
field level, allowing you to include and exclude detailed field information. Activity Statement 
customized templates only let you include and exclude sections.

You generate and run Activity Flex Queries from the Activity Flex page. You generate and run 
Trade Confirms Flex Queries from the Trade Confirmation Flex page. Both are accessible from 
the Reports menu in Account Management. For detailed instructions, see the Reporting 
Guide.
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Statements and Reports: PortfolioAnalyst
PortfolioAnalyst

PortfolioAnalyst allows you to evaluate the performance of your IB portfolio by creating and 
saving reports based on a set of measurement criteria and optionally comparing their data to 
selected industry benchmarks. You can create Detailed PDF Reports, which let you select any 
combination of report sections for a variety of performance analyses, or Snapshot PDF 
Reports, which are one-page summaries of an account's return, NAV, asset allocation and 
distribution of returns. Once you create and save reports, you can run, edit or delete them.

Fund Investment Managers can also create and save synopses (custom cover letters) and 
assign them to Detailed PDF reports.

One report you can include in a Detailed PDF Report is the Performance Attribution report. This 
report shows how your asset allocation and selection of securities affects your portfolio’s 
performance when compared to the performance of the S&P 500 Index over a specified time 
period. This report includes a summary table, line and bar charts, and a scatter plot that 
shows how you outperformed or underperformed the S&P 500. For more information about 
this report, see Running a Performance Attribution Report.

You access PortfolioAnalyst from the Reports menu in Account Management. For detailed 
instructions on using PortfolioAnalyst, see the Reporting Guide.
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Statements and Reports: PortfolioAnalyst
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Open a PaperTrader Account 
Open a PaperTrader Account

Once your account has been approved and funded, you are eligible to open a Paper Trading 
Account. All paper trading accounts start with 1,000,000 USD of paper trading equity, which 
allows you experiment with the full range of IB trading facilities in a simulated environment 
which uses real market conditions. 

Once you complete the application, the paper trading account is available within 24 hours 
under normal business circumstances. You will be notified by email when the account is ready 
for trading.

To apply for a paper trading account

1   Log In to Account Management.

2   CClick Manage Account > Settings > Paper Trading.

3   Click Continue.

The following page opens:

4   Type a five-character paper trading account username in the field provided.
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Open a PaperTrader Account 
5   Type a paper trading account password in the field provided. The password must be 
from six to eight characters and must contain at least one number and no spaces.

6   Re-type the password in the field provided, then click Continue. The system will 
generate a full username for you when you click Continue.

7   You are prompted to click Yes to confirm your request for a paper trading account, or 
click No to cancel your request.

Be sure to write down your username and password; your password will not be shown 
on the screen again.

For more information, see the PaperTrader page on the IB website. 

For details on managing your PaperTrader account, see the Account Management User’s 
Guide. 
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Open a PaperTrader Account 
Paper Trading Account Reset
All paper trading accounts start with 1,000,000 USD of paper trading equity. You may reset 
this equity at any time using the Paper Trading Account Reset page in Account Management 
(log in with your paper trading account username and password).

Paper Trading Account Statements
The Paper Trading Account Statements page lets you view and print daily statements for your 
paper trading account, and download trade information to Microsoft Word and Microsoft Excel. 
Daily statements cover the last 45 days. Log into Account Management with your paper 
trading account username and password.
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Open a PaperTrader Account 
Password Change
Use the Password Change page to change your paper trading account password.
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Use Soft Dollars
Use Soft Dollars

Interactive Brokers offers Investment Managers of Multiple Fund accounts the flexibility to 
offset the costs of purchasing approved research products and services using soft dollars. Soft 
dollars are brokerage commissions that are used to purchase research products and services 
from vendors. For example, suppose that mutual fund XYZ wants to buy research from the 
ABC brokerage firm. XYZ offers to pay for the research by agreeing to spend at least $10,000 
in commissions for brokerage services in exchange for the research. This would be a soft 
dollar payment. 

If you have set up and are using soft dollars, your activity statements will show all of your soft 
dollar payments in the Soft Payments section of your statement. You can also choose to 
include or omit the Soft Payments section from activity statements when you create 
customized activity statement templates and Activity Flex queries.

Soft Dollar Tiers

To set up soft dollar tiers

1   Contact an IB Sales representative to request that an IB Account Number be set up for 
each vendor to whom you want to disburse soft dollars.

2   Once the vendor accounts are set up, login to Account Management, then click Manage 
Account > Settings > Fees > Soft Dollar Configuation.

3   Enter values in the Markup Schedule fields for each tier. Values are in dollars per share 
and must be between 0 and 0.05.

The dollar amounts for the five tiers must be in ascending order, with the lowest 
amount in Tier 1 and the highest amount in Tier 5. If you enter soft dollar amounts in 
non-ascending order, the system automatically rearranges the amounts in ascending 
order for you.

4   Click Continue.

5   Confirm your soft dollar markup schedules by clicking Continue. The Account 
Management home page opens.
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Use Soft Dollars
The following figure shows the Soft Dollars page in Account Management.

The Soft Dollars page shows the current and last markup schedule for soft dollars for 
five tiers. The first time you use soft dollars in Account Management, these fields are 
set to 0 (zero). Set up soft dollar tiers by entering values in the Markup Schedule fields 
for each tier. Values are in dollars per share and must be between 0 and 0.05.

For complete instructions on how to set up soft dollar tiers, see the Request Soft Dollars topic 
in the Account Management Users’ Guide.

Soft Dollars Disbursement
Use the Funding > Soft Dollars Disbursement page to view existing soft dollar 
disbursements to vendors with IB account numbers. This page is only accessible after soft 
dollar vendor accounts have been set up at IB, and displays:

•   All past soft dollar disbursements to the selected vendor, including the vendor ID, 
name, and the total amount disbursed. If there are no past disbursements to the 
selected vendor, the total amount disbursed is shown as zero. The Amount Requested, 
Status and Cancel fields are left blank.

•   All current soft dollar disbursements to the selected vendor, including the vendor ID, 
name, the total amount already disbursed to the vendor, the total amount currently 
requested and the status of the request.

For complete instructions on how to use the Soft Dollars Disbursement page, see the Soft 
Dollars Disbursement topic in the Account Management Users’ Guide.
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